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Archivers Overview
Welcome to KnowWare's Archivers program.    Archivers provides you with a quick, intuitive Windows 
interface for using the file compression programs ZIP, ARJ, LZH and Microsoft's Compress and Expand 
programs.    As you can see, the Archivers window is laid out with a Source and a Target directory visible 
on your screen.    This allows you to see and control all of the Archivers functions as you uncompress or 
compress files from the Source into the Target directory.    Archivers also offers the ability to view the 
contents of Zip, Lzh and Arj files before uncompressing them.    The Archivers menus provide quick 
access to all of the uncompression and compression commands, and, for added speed, Archivers also 
provides an "instant menu" which can be accessed anywhere in the Archivers window by clicking on your 
right mouse button.    This provides you with instant access to the more frequently used menu items.    You
will also notice that Archivers does not limit itself to file compression and uncompression.    It also offers a 
complete file management system; allowing you to create directories, delete directories, copy and move 
files, search for files, view and execute files, and backup system files - all directly from the Archivers 
window.    By double clicking on files, you can also view text files, BMP files and GIF files, as well as 
execute EXE files.    There is also a user-defined text editor and graphics viewer, which further expands 
the possibilities for viewing text and graphics files.

The purpose of the Archivers program is to make it as easy as possible for you to organize all of those 
compressed files that you download from the internet and online services, and also to compress your own
files for storage or transportation.    Archivers puts all of the tools you need into one place so that you can 
control the clutter on your system and get the most out of your computer.    

Sub-Topics:
What You Will Need
Troubleshooting
Legal Stuff



What You Will Need
There is one setting in your Windows program which must be set correctly in order for Archivers to work.   
In your "Main" Windows program group choose "Control Panel."    In Control Panel, open up the 386 
Enhanced item.    Under "Scheduling" you will see a check box for "Exclusive in Foreground."    In order for
Archivers to run properly this box must not be checked, since Archivers does much of its work in the 
background.

The compression program that you are likely to use most often is "PKZIP"    If you don't already have this 
program, you will need to get it in order for this archiving program to work.    You can find the PKZIP 
shareware program, PKZ204G.EXE, on any online service (such as America Online or CompuServe) or 
on many BBSs.    It is a Shareware program which has a $47.00 registration fee.    PKZ204G.EXE is a 
self-extracting EXE which contains a group of EXEs that perform different tasks.    For the Archivers 
program, you will need PKUNZIP.EXE, ZIP2EXE.EXE, PKZIPFIX.EXE and PKZIP.EXE.    The PKZIP 
program is generally considered the industry standard for compression.    Much of what you download 
from online services and BBSs will be in the *.ZIP format.    PKZIP works by taking a group of files and 
compressing them into one file.    When you download a ZIP file of a program, it will contain all files 
necessary for running the program.    You can also use PKZIP for storing groups of files that you don't use 
very often and want to store on a disk.    PKZIP compresses the files so that you can store more on a disk,
and then you can quickly unzip them again if you need to use them.

The two other compression programs that you can access using the Archivers window are LHA (files have
the .LZH extension), and ARJ.    These are two other extensions that you may run into out in cyberspace.   
LHA is a free shareware compression program that you should also be able to find online.    The 
compressed EXE file is LHA213.EXE (EXE name depends on version), but the actual EXE that you need 
for the Archivers program is LHA.EXE.    LHA creates compressed files with the LZH extension.

ARJ is another popular compression program.    It is a shareware program which can be registered for 
$40.00.    The compressed EXE is ARJ239a.EXE or ARJ250.EXE (these are the two most recent 
versions) and should also be available on most online services.    The EXE that you need for the Archivers
program is ARJ.EXE.    It creates compressed files with the ARJ extension.

In order for the Archivers program to work, all of the EXE files for these three compression programs must
be loaded into your computer and located in a directory within your path (e.g. the DOS directory).    Your 
path statement is located in your AUTOEXEC.BAT file.    (A typical path statement would be:    PATH = C:\
DOS; C:\WINDOWS; C:\UTILS    etc.)    Archivers will check for you to see whether all of these programs 
have been installed properly.    In the Archivers Options menu (or using the instant pop-up menu with the 
right mouse click) choose "Check Installed Components."    You can also look to see what your path 
statement says by choosing "Show DOS Path."

The Microsoft compression programs Compress.exe and Expand.exe are included with the Archivers 
program and have already been loaded into your Windows directory.    These are accessed using the 
"Compress" menu on the Archivers screen.



Troubleshooting
In order for Archivers to work properly, all of the EXE files listed in What You Will Need need to be loaded 
into your computer and located in your path (e.g. the WINDOWS or DOS directory).    Archivers will check 
for you to see whether all of these programs have been installed properly if you choose "Check Installed 
Components" from the Archivers "Options" menu.

Another item to verify, if Archivers is not working correctly, is the check box in your Windows 386 
Enhanced program.    Complete instructions on this can also be found in What You Will Need.

The following files were installed by the Archivers setup program into your Windows directory.    They 
MUST remain there un-altered in order for Archivers to work properly.    

ARCHIVER.PIF
ARCHCOMP.PIF



Legal Stuff
Archivers is a Shareware program.    We encourage you to register this program if you are using it.    You 
can access the Registration form through the Help menu of the Archivers window.    Registration is $20.00
(including shipping and handling).    Fill in the blanks in the registration form and then print it out and send 
it in to KnowWare with your check or money order (US Currency only).    As you may know, the Shareware
concept is based completely on the honor system.    Only in cyberspace do people still trust each other 
enough to distribute their merchandise freely and rely on their neighbors to pay for what they use.    We at 
KnowWare are firm believers in the shareware concept.    We ask only that if you use our program you 
pay for it.    Feel free to try it out for 30 days.    If you like it and are using it, we ask that you register it at 
that time.    When we receive your registration we will send you an updated, registered version of 
Archivers.

You can reach KnowWare though e-mail.    We welcome any comments or questions you may have.    

Program written by Gary Pease:      knoware@pioneer.net
Documentation by Cindy Dyrness:    Cdyrness@aol.com or 75573,1717 (C-Serve)

KnowWare's Home Page:    http://www.pioneer.net/~knoware/

Check out our home page for the newest releases and information on all of our programs.

This program is provided "as is" without representation or warranty of any kind, either expressed or 
implied, including without limitation, any representations or endorsements regarding the use of, the results
of, or performance of the program and information, its appropriateness, accuracy, or reliability.    The entire
risk as to the use of this program and information is assumed by the user.    In no event will KnowWare or 
Gary Pease or Cindy Dyrness be liable for any damages, direct, indirect, incidental or consequential, 
resulting from any defect in the program or information.



Archivers Menus and Button Functions
Click on the different areas of the Archivers window to learn about how it works.



Exit
This closes the Archiver program and returns you to Windows.    You can also exit Archivers by clicking on
the right mouse button and choosing Exit from the pop-up menu.



Help Menu
The Help menu gives you access to this help file.    It also gives you access to the Archivers Registration 
form.    We encourage you to register this program if you are using it.    Registration is $20.00.    Fill in the 
blanks in the registration form and then print it out and send it in to KnowWare with your check or money 
order.



Options
The Options menu gives you access to other important Archiver functions.    The first options are Reset 
form Controls and Clear form Selections.    Use Reset Controls to set everything back to default 
settings and the directory boxes back to the root directory.    Use Clear Selections when you change your 
mind about a group of files that you have selected and want to start again.    The next option is Compare 
Directories.    Go to Compare Directories for complete information.    The next option in the menu is View 
Compression, Uncompression operations.    When this option is checked (click on it to check or 
uncheck it), Archivers provides you with a DOS window during the process of uncompression, 
compression, or backup, so that you can see the progress of the operation.    The next options, New 
Search and Previous Search, allow you to search for a file on your system.    See Search Function for 
more information about this function.    The next option is Change File Attributes.    See Change File 
Attributes for complete information.    The next option, Format Floppy Disk, is described in Format Disk.   
The next option is DOS Window.    This opens up a DOS session window from Archivers and allows you 
to work in DOS.    Type "exit" at the DOS prompt when you are ready to close the DOS window and you 
will be returned to the Archivers screen.    The next two Option items are View "autoexec.bat" Path and 
Check for Installed Components.    Go to DOS Path/Installed Components for information about these 
options.    The next Option items are Backup Necessary System Files and Help on Backup.    Go to 
Backup System Files for complete instructions on backing up your system files.    

The final Option menu item is Keep On Top When Minimized.    This option can be toggled on or off by 
clicking on it.    When it has been selected (it has a check mark next to it when selected), the minimized 
Archivers icon will stay on top of any other Windows application.    This option is not enabled when 
running Windows 95 because the minimized program is accessible from the "Task Bar."

NOTE:    You can also access all of these Option items (except Keep On Top) with the right mouse click 
pop-up menu anywhere in the Archivers window!



Uncompress Menu
This menu you gives all of your options for uncompressing files.    You will notice that different menu items
are highlighted depending on which file you have chosen.    If you have a .zip file highlighted in the Source
file list box, then the UnZip options will be active:    Un zip, Un Span, Un zip /test, and View Zip File.    
Likewise, if you have an .lzh file chosen, the Un Lzh items will be highlighted, and if you have an .arj file 
chosen, the Un Arj items will be highlighted.    There is also the MS Expand file(s) for expanding 
Microsoft's compressed files, the Extract Exe option for uncompressing self extracting exe files and 
Extract Selected List Files which is activated when you select more than one file to uncompress.    You 
can also access these menu items with the right mouse click "instant menu."    The instant menu will show
the proper uncompression program for whichever file you have chosen.    For complete information on all 
of these uncompression programs see Unzipping, Uncompressing LZH Files, Uncompressing ARJ Files, 
Compress and Expand Programs and Self Extracting EXE Files.



Compress Menu
This menu gives you access to all of the ZIP, LHA and ARJ compression options, as well as the Microsoft 
Compress program.    The first option is the MS Compress file(s) command.    For details about this, go to 
Compress and Expand Programs.    The next item is Zip Options.    Clicking on this reveals a sub-menu 
with eight different options for compressing files and directories using the PKZIP program.    For details 
see ZIPPING.    The next item is LZH options.    The LZH sub-menu gives you three options for 
compressing files using the LHA file compression program.    For complete instructions see LZH Menu - 
File Compression.    The final Compress menu item is ARJ Options.    The ARJ sub-menu lists three 
options for compressing files using the ARJ file compression program.    For complete instructions see 
ARJ Menu - File Compression.    



Chooser
The Chooser menu gives you the Select Editor/Graphics Viewer option which brings up a selection form 
which allows you to choose your own text editor to add to the "Editors" menu and your own graphics 
viewer for the "Viewer" menu.    Go to "Chooser Instructions" for complete instructions.



Editors Menu
This menu gives you three options for text editors to use for viewing text files.    You can also add your 
own text editor by using the selection form in the Chooser menu.    For more information, see Archivers' 
Editors or "Chooser Instructions".



Viewer
This menu contains your own graphics viewer if you have selected one in the Chooser menu.    If you do 
not have a viewer selected, this menu only contains a message telling you that a graphics viewer has not 
been selected.    Go to "Chooser Instructions" for instructions on selecting a graphics viewer.



Source File List and Directory List Boxes
Used for choosing the file or directory that you want to compress, uncompress, copy or move.    You can 
select a single file by clicking on it or select multiple files by holding down the mouse button and selecting 
a group of files, by holding down the Control key and clicking on the files that you want to select, or by 
choosing a file extension in the file extension box above the file list box.



Target Directory List Box
Used for choosing the directory that will be the destination for your compressed or uncompressed files, or 
your copied or moved files.



Target File List Box
The File List box shows whatever files are within the presently selected directory.    After you uncompress 
a compressed file, its contents appear in the Target File List Box.    You can then double-click with your 
mouse on a text file to view it, double-click on an EXE file to execute it, or double-click on a BMP or GIF 
file to view it.    See Archivers' Editors, Executing EXE Files, or Viewing BMP and GIF Graphic Files for 
more information.    You can also select a single file in this box by clicking on it or select multiple files by 
holding down the mouse button and selecting a group of files, by holding down the Control key and 
clicking on the files that you want to select, or by choosing a file extension in the file extension box above 
the file list box.



Extension Box
The file extension box allows you to choose which files you want to view in your file list box.    You can use
it to view only your zip files, for example, by choosing the *.zip extension.    Only the files with the 
extension you have chosen will appear in your file list box until you set the file extension box back to *.*.    
You can also use the file extension boxes for choosing files to copy, move or delete.    If you have the *.zip
option chosen, for instance, and you choose Copy Source Files, all of the zip files will be copied from the 
Source directory, but no files without the .zip file extension will be copied.    (Note:    If you have one or 
more of the zip files selected, the program will only copy those files that you have selected.)    You can 
also type your own file extension into this box to view any extension you would like to.



Path Statement
This is the DOS path for the compression or uncompression operation that you are performing.    This 
path statement is actually a text box which it is possible to edit. 



Delete File(s) Button
This button will delete a single file if you have a single file selected, or a group of files if you have a group 
selected in the file list box.    (Use the red printed button for the Source side or the black printed button for 
the Target side.)    Select multiple files by holding down the mouse button and selecting a group of files, by
holding down the Control key and clicking on the files that you want to select, or by choosing a file 
extension in the file extension box.    If you have NO files selected, clicking on this button deletes all files 
in the highlighted directory (or all of the files with the extension you have chosen in the file extension box).
The program will always prompt you for confirmation before it deletes files.



Del Dirs Button
This button gives you the option of deleting a directory along with all of its subdirectories and everything 
they contain, all in one shot.    If a directory contains no subdirectories, Del Dirs will simply delete that 
directory and everything in it.    Use the red printed Del Dirs button on the left to delete Source directories 
and the black printed Del Dirs button on the right to delete Target directories.    The program will prompt 
you before it deletes the directories to make sure you really want to do it.



Mkdir Button
The Make Directory button allows you to make a subdirectory from wherever you are.    Simply click on 
whatever directory you want to make a subdirectory of (in either the Source or Target list box) and then 
click on Mkdir (the red Mkdir on the left for Source and the Black Mkdir on the right for Target).    A box will 
come up with a blank text box.    Type in the name of your subdirectory and then click on OK or push 
Enter.    You will see the new subdirectory appear in the directory list box.



RD (Remove Directory) Button
The RD button will delete whichever directory you have highlighted, as long as it has no files in it.    The 
red printed RD button on the left will remove a Source directory and the black printed RD button on the 
right will remove a Target directory.



Rename File Button
This button allows you to change the name of any file.    Highlight the file that you want to change the 
name of in either the Source or Target file list box and then click on the Rename File button (the red 
printed Source button on the left or the black printed Target button on the left).    A box will come up with 
the name of the file highlighted.    Simply type in the new file name (with extension) and click on OK.    You 
will see the name of the file change immediately in the file list box.



Dir/File Size Button
The Dir/File Size button gives you the number of files and the number of bytes in the directory that you 
have open in either the Source or Target file list box, or gives you the size of any group of files that you 
have selected.    If a directory has subdirectories, the program will ask you whether you want to include 
the subdirectories in your file total.    You can multi-select a group of files by holding down the mouse 
button and selecting a group of files, by holding down the Control key and clicking on the files, or by 
selecting a file extension in the file extension box above the file list box on either the Source or Target 
side.    Then click on the Dir/File Size button to find the total bytes in the selected files.    Choose the red 
printed button on the left for the Source directory or the black printed button on the right for the Target 
directory.    The information is displayed in the lower right hand corner of the Source side or the Target 
side.



Copy Source File(s) Button
When you click on this button, the program copies whatever you have chosen in the Source file list box 
into whatever you have chosen in the Target directory list box.    If you have a file highlighted in Source 
and a directory highlighted in Target, the program will copy the Source file into the Target directory.    If you
have not chosen a file in the Source file list box, the program will assume that you want to copy all files 
from the Source directory (*.*) into the Target directory.    (The program will ask you first, to make sure you
want to do this.)    You can also copy a group of files by holding down the mouse button and selecting a 
group of files in the Source box, by holding down the Control key and clicking on the files that you want to 
copy, or by choosing a file extension other than *.* in the file extension box.    After copying, the program 
displays the number of files and number of bytes copied in the lower right hand corner of the Target area.  
You can also access the Copy command by using the right mouse button "instant menu."



Move Source File(s) Button
The Move button works just the same as the Copy button except that it does not leave the files behind in 
the Source Directory.    Choose a file in the Source file list box and a directory in the Target list box and 
then push the Move button.    The file will immediately be moved to the Target directory.    If you have no 
file chosen, the program will assume that you want to move all files from the Source directory and it will 
prompt you to make sure that this is what you want to do.    You can also move a group of files by holding 
down the mouse button and selecting a group of files in the Source box, by holding down the Control key 
and clicking on the files that you want to move, or by choosing a file extension other than *.* in the file 
extension box.    You can also access the Move command by using the right mouse button "instant menu."



Chooser Instructions
The Chooser form allows you to select a text editor and a graphics viewer from your own system to be 
added to the Editors menu and the Viewer menu of Archivers, for use in viewing text and graphics files.    
Use the Windows Groups and Program Items drop down list boxes on the Chooser form to choose the 
text editor or graphics viewer that you want to use.    After you have chosen your program under Program 
Items, go up to the Options menu and select "Add Editor to Archivers Menu" or    "Add Graphics Viewer to 
Archivers Menu."    You will then see it appear under "Current Editor Selection" or "Current Viewer 
Selection."    If you want to set your text editor or graphics viewer as the default, click on the box next to 
"Set Editor as Default Editor" or "Set Viewer as Default Viewer."    When you select your program as the 
default it appears in the menu with a check mark next to it.    This means that Archivers will always use 
your text editor or graphics viewer when you double-click on a text file or graphics file.    For text files, 
however, you can choose a text file and then open the Editors menu to choose a different editor such as 
Notepad or Write.    

If you do not set your editor or graphics viewer as the default, it will appear in the menu without a check 
mark next to it and files will not automatically be opened into it when you double click on them.    If you 
want to view a file using your text editor or graphics viewer you need to go and choose it from the menu.   
Otherwise, Archivers will use its own built-in defaults for viewing text and graphics files.    Note, however, 
that if you double click on a graphics file other than a BMP or GIF file, Archivers will automatically default 
to your chosen graphics viewer, even if has not been set as the default.    Only bitmap and GIF files can 
be viewed natively within the Archivers program.

If you want to remove your text editor or graphics viewer from the menu, go to the Options menu in the 
Chooser form and choose "Remove Editor from Archivers Menu" or "Remove Viewer from Archivers 
Menu."



Option Menu Items
Compare Directories
Search Function
Change File Attributes
Format Disk
DOS Path/Installed Components
Backup System Files



Compare Directories
To use the Compare Directories function, you must first choose the two directories you want to compare 
in the Source and Target directory list boxes.    The Compare Directories function allows you to compare 
the contents of two directories and find out whether the files within them match - not only filenames but 
also the times and dates of the files.    This function is especially useful when you are working on a group 
of files that you want to keep backed up.    Using the Compare Directories function will show you right 
away which files have been changed or added, and you can then use the Update Directories options to 
update the files.

Click on the different areas of the Compare Directories form to learn about its functions.



Exit
This closes the Compare Directories form and returns you to Archivers.



Clear Update Options
This clears out any options that you have chosen under "Update Directories Options."



View Options
The View Options menu gives you the chance to manipulate the non-matching Source and Target files.    
These are the "extra" files that the Compare program finds in either the Source or Target directory.    
Under View Options you can take a look at these files and you have the option of copying them, moving 
them or deleting a file or any combination of files.



Help
The Help menu gives you access to Help information specific to the Compare Directories function, as well
as to the entire Archivers Help file.



Comparison Results Window
This is where the results of your directory comparison are listed.    The matching files are listed first and 
then the files that have the same name but a different date and/or time and finally the files that do not 
match at all.



Update Target
The Update Target With New Source Files option will replace the older matching Target files with the 
newer matching Source files, making these files identical in both directories.



Update Source
If the Target directory has newer files than the Source directory, this option will replace the older Source 
files with the newer Target files, making the files identical in both directories.



Update Both
The Update Both Ways with Newer Files option will update older files in both the Target and Source 
directories with any newer matching files.



Replace Target
The Replace Target Dir Files with Source Dir Files will remove all files from the Target directory and then 
copy over all files from the Source directory.



Replace Source
The Replace Source Dir Files with Target Dir Files will remove all files from the Source directory and then 
copy over all files from the Target directory.



Delete Non-Matching
The Delete Non-Matching Source and Target options will delete those files in whichever directory you 
choose that do not correspond to any file in the opposite directory.



Update Dirs Button
This is the button to click on after you have chosen your Directory Update options to carry out the 
updating that you have chosen.



Search Function
The "Search" item in the Options Menu will search for a file or group of files on your system or any portion
of your system.    To use the Search function, click on the "Search New" menu item and the Search 
window will appear.      The "View Old Search" option will bring up the Search window with the results of 
your most recent search.    You can also access the Search options using the right mouse button click to 
bring up the "instant menu."    

Click on the different areas of the search window below to find out about how it works.



Search Results Box
This list box displays the results of your search.    You can then use this list box to perform various 
functions with the files your have found.    You can multi-select files in the list box by holding down the left 
mouse button and dragging your mouse over the files you want or by holding down the Control key on 
your keyboard and using the mouse to click on the files you want one by one.    You can then delete or 
copy the files you have chosen using the Delete or Copy File(s) buttons (or access Delete and Copy by 
clicking on the right mouse button and selecting them from the pop-up menu.)    You can also double click 
on text files in the list box to load them into Notepad or Write (or your own text editor if you have one 
chosen), double click on graphics files to view them as you would in the Archivers main screen, and 
double click on EXE and help files to execute and view them.



Search String Box
This is the box in which you type what you are searching for.    If you know the complete name of the file, 
type it in here.    If you want to search for all files with a particular extension, use the * wildcard; e.g. *.txt 
or *.exe.    You can also use the wildcards if you can't remember exactly what the file is called; e.g. 
my*.doc or doc*.*.



Search for Duplicates
This useful search option allows you to search for duplicate files on your system.    You can search for all 
duplicates, or you can search for duplicates with a certain extension, such as *.dll, by typing the extension
into the Search String box.    You can search your entire system by choosing your root drive (e.g. C:\) in 
the directory list box, or you can search just your DOS path or just your Windows and    Windows\System 
directories by choosing those options below.    When the search is complete, Archivers will list all of the 
duplicate files in the Search Results box.    Then you can use the Delete or Copy functions to get rid of the
duplicates.



Search DOS Path Only
This will perform a search only in those directories which are listed in your DOS path in your autoexec.bat
file.



Search Windows/System Only
This will search only your Windows directory and your Windows\System directory for the search string.



Directory List Box
This lists all of the directories on your system.    If you want to search your entire system, make sure that 
your root drive is chosen in this box (e.g. C:\) and not a directory.    If you want to search only in a 
particular directory, simply click on that directory to select it.



Begin Search
Click on this button when you are ready to start your search.    You can also begin your search by clicking 
on the right mouse button and choosing Begin Search from the pop-up menu.



Copy File(s)
Click on this button to copy or move any files that you have selected in the Search Results box.    A form 
will come up that allows you to choose the destination directory, and you can also choose whether you 
want to copy the selected file(s) or move them.    You can also copy files by clicking on the right mouse 
button and choosing Copy File(s) from the pop-up menu.



Delete File(s)
Click on this button to delete the files that you have selected in the Search Results box.    You can also 
delete files by clicking on the right mouse button and choosing Delete File(s) from the pop-up menu.



Cancel
The Cancel button closes the Search window and returns you to Archivers.



Reset
Reset clears out the previous search and resets the form back to its default settings.



Change Directory
To use Change Directory, choose a file in the Search results box and then click on Change Directory.    It 
will return you to the Archivers main screen and reset the Archivers Source directory to the directory of the
file you have selected.    You will also notice that the file you have chosen will be highlighted in the Source 
file list box and will be the only file that appears.    A single click on the Source directory will make all of the
files in that directory reappear.



Editors
The editors menu lets you choose either Notepad or Write to view a text file.    Double clicking on most 
text files will automatically load them, but if the file has an unusual extension, you can click on it and then 
load Notepad or Write in order to view it.    If you have your own text editor chosen as the default for 
Archivers, text files from the search screen will be loaded into that program instead of Notepad or Write.



Exit
Exit closes the Search window and returns you to Archivers.



Help
The help menu takes you to the Help topic which explains the Search function.



Change File Attributes
The Change File Attributes function can be accessed using the Options menu or by clicking on the right 
mouse button and bringing up the "instant menu."    You must select a file or group of files before bringing 
up the Change File Attributes form.

The four attributes that are controlled by the Change File Attributes form are normal, read-only, hidden 
and system.    Most files on your computer are attributed as "normal."    Some files that are important to 
the working of your system are given other attributes by the computer manufacturer.    Read the following 
for an explanation of the different file attributes.    Click on the file that you want to change the attribute of 
in the Change Attributes form.    The file's present attribute will appear in the text box in the upper right 
hand corner.    Choose one of the buttons to change the file's attribute.

The first choice, "Attrib as Normal," will undo any file attributes and make the file into a "normal" 
unattributed file.    

The next button, Attrib +r turns on the "Read-Only" attribute of a file.    When a file is Read-Only it can be 
viewed but cannot be deleted or modified.

The next choice, Attrib +s, turns on the "System" attribute of a file.    The System attribute indicates that a 
file is used as part of the operating system.    System files are hidden.    They can be viewed (once you 
know they are there) but cannot be changed or deleted.    (Note:    System and Hidden files are visible 
within the Archivers program.)

The next button, Attrib +h turns on the "Hidden" attribute of the selected file.    When a file is set as hidden,
it is not listed in any normal directory listing in Windows or DOS.    Hidden files are generally files so vital 
to a program's operation that it is considered best to not even let people know they are there.    Hidden 
files are also Read-Only.    You can view them, but you cannot change or delete them.

The next three buttons, +h +r, +r +s, +s +h, and +r +h +s, give you some choices for combinations of 
attributes that you might want to add to your files.

The attributed files on your PC are obviously very important to the functioning of your system.    Be very 
careful when using these attribute options.



Format Disk
Format Disk formats a floppy disk in your disk drive.    The Format form can be accessed from the Options
menu or by clicking the right mouse button and bringing up the "instant menu."    The program will prompt 
you for some information about what sort of formatting you want to do, what disk drive you are using, and 
what size the disk is

Click on the options below to learn about the different possibilities for formatting a disk.



Format (default)
This is the regular DOS format command.    Use it for general-purpose disk formatting.



Unconditional /u
This is the lowest level of disk formatting.    With the regular format command you can actually do an "un-
format" and sometimes restore some of your data, but the unconditional format completely wipes out any 
data you may have had on the disk.    



System Files /s
This format command copies the system files onto the disk as part of the format operation.    The three 
system files (IO.SYS, MSDOS.SYS and COMMAND.COM) make the disk bootable.    This means that 
your computer could boot up and load DOS by using this disk if something was wrong with your hard 
drive.    NOTE:    This option is disabled when running Windows 95 (as in this screen shot).    Windows 95 
needs different files in order to make a boot disk and you must use the Windows 95 backup program to 
do this.



Bad clusters? /c
This is the format command to use if you believe that your disk has bad clusters.    The /c switch will retest
all of the clusters to see whether they are bad, and if they are Format will mark them as bad so that they 
will not be used.    More information about these format switches can be found in DOS help.



Drives
You must choose a drive for the format command to work.    Choose the drive where the disk you want to 
format is.



Disk Type
You must also choose a disk type, so that the computer knows what sort of disk to format.    Most 
computers now use the 1.44M 3.5" disks.



Exit
Clicking on Exit closes the Format window and returns you to Archivers.



Help
The Help menu gives you access to specific help on the Format window and to the Archivers help file.



Default
Clicking on Default will set the Format options to Format (default), a: drive, 1.44 M 3.5" disks.



OK Button
This is the button that you click on when you are satisfied with your format choices and you are ready to 
go ahead and format your disk.



Cancel Button
The cancel button closes the Format form without taking any action.



DOS Path/Installed Components
When you click on View "autoexec.bat" Path in the Archivers Options menu, Archivers displays the DOS 
path which is a part of your computer's autoexec.bat file.    The DOS path tells your computer where to 
look for important program files.    The PKZIP, ARJ and LZH programs must be located in one of the 
directories listed in your DOS path.    (Note:    If you edit the DOS path in your autoexec.bat, the "Show 
DOS Path" option will not reflect the changes until your computer is rebooted.)    The "Check for Installed 
Components" Option item searches your system to see if you have the PKZIP, LHA and ARJ programs 
properly installed on your system and then displays the results of its search.



Backup System Files
Archivers provides an automatic backup program which creates zip files containing your important system
files.    It backs up your Windows *.ini, *.inf, *.pwl, *.dat and    *.grp files, and your autoexec.bat and 
config.sys files.    It then zips them all into separate zip files in a directory called "sysback."    You can then 
take the zip files and copy them onto a disk or other medium for storage.    During the backup process, 
Archivers also generates a report which lists all the files that have been backed up.    You can print out this
report or save it as a text file with your backups so that you have a record of what was backed up.



PKZIP
View Zip File
Unzipping
ZIPPING



View Zip File
Using View Zip File gives you the opportunity to view the contents of your ZIP files before opening them.   
You can access this utility by either double clicking on a zip file in the Source or Target list box, choosing 
"View contents of Zip File" from the Un Zip/Lzh/Arj menu after selecting a zip file in the Source or Target 
list box, or by clicking on the right mouse button and bringing up the "instant menu" (after selecting a zip 
file in the Source list box).    View Zip File gives you a list of all the files within your zip file and details 
about the compressed and uncompressed size of the file.    Another useful feature of the View Zip File 
utility is that it allows you to view text, help, bitmap and gif files from within your zip file without unzipping 
it!    Simply double click on any file with a .txt, .wri, .hlp, .doc, .bat, .me, .1st, .bas, .bmp or .gif extension 
and the program will automatically uncompress the file and bring it up on your screen for you to read or 
view.    When you're finished viewing the file just close it.    The text file remains in your zip file.

Sub-Topics:
Options



Options
NOTE:    All of the menu items listed below can also be accessed by using the right mouse click pop-up 
menu in the View Zip File window.

The first tool in the View Zip File Options menu is "Delete Selected Files from File."    This allows you to 
remove selected files from your zip file without uncompressing it.    Simply choose the file or files (select a 
group of files by holding down the mouse button and selecting a group of files, OR by holding down the 
Control key and clicking on the files that you want to select) that you want to delete and then choose the 
"Delete Selected Files" option.    The files you have selected will be removed from the zip file, leaving the 
rest of the zip file intact.

You can also extract a single file or selected files by selecting the files (once again,    by holding down the 
mouse button and selecting a group of files, OR by holding down the Control key and clicking on the files 
that you want to select) and then choosing "Extract Selected Files from File" from the "Options" menu.   
The View Zip File box will then ask you to choose a destination directory to extract the files into and will 
extract only the selected files into the selected directory.

The next item in the Options Menu is "View Selected File (Text)" which accomplishes the same thing as 
double clicking on a text file as described above (i.e. allow you to view the file).    And the final Option is 
Anti Virus Scan.    When you choose this option, Archivers runs a virus scan program which checks the 
entire zip file.    It then creates a report to show you whether any viruses were found.    (NOTE:    On some 
computers the Anti Virus Scan process may generate an error message about being "unable to access 
the video display."    If this happens, simply click OK in the error message and the virus scan will be 
completed normally.)

The "Clear" menu option of the View Zip File box will clear out any selections that you have made and let 
you start over again.



Unzipping
In a Nutshell:    To unzip a file in Archivers; choose the file in the Source file list box on the left, choose the 
destination directory in the Target directory list box on the right, go to the Un Zip/Lzh/Arj menu and choose
Unzip, and Voila!    The unzipped files appear in the Target directory.

For more detail, please read on:

The first step in uncompressing a file is to choose the file you want to uncompress and click on it once.    
This will tell the Archivers program which uncompression program to use.    If you're working with a 
directory that contains many different kinds of files and you have trouble finding the file you want, you also
have the option of choosing a file extension in the file extension box in the upper left-hand corner.    For 
instance, if you want to find all of the ZIP files, go up and choose the *.zip extension.    Once you have 
done this, only ZIP files will appear when you look into your directories.

The next step is to choose the target for your uncompression process.    The important thing to remember 
about uncompressing or compressing files in the Archivers window, is that you must choose both the 
Source file (or files), on the left side of the window, and the Target directory on the right side of the 
window.    You have to do this even if you are unzipping or zipping something into the same directory (i.e. 
the source and the target directories are the same).    You will notice that when you choose the Source 
and the Target that their paths appear above each file list box.    By looking at these you can verify that the
Archivers program is correctly reading the file or directory that you have chosen.

So, after you have clicked on the file you want to unzip in the left-hand file list box, and chosen a 
destination directory in the right hand list box, go to the Un Zip/Lzh/Arj menu.    You will notice that only the
uncompression options for the correct program are highlighted.    To uncompress a ZIP file, simply click on
the "Un Zip file" menu item.    You will see the hourglass appear as Archivers unzips the file and then you 
will see the unzipped files appear in the right-hand file list box.      (Note:    if you have "Visual On" chosen 
in the Options menu, you will see a DOS window appear during the unzipping process and you can watch
as each file is uncompressed.)

The Archivers program runs a test on the ZIP file before it executes it.    If it finds a ZIP file that has been 
corrupted, you will get a message that reads "There is a problem extracting this file.    Would you like to 
run Pkzipfix to try to correct this?"    Pkzipfix can often do a pretty good job restoring your ZIP file.    If you 
choose Yes,    Pkzipfix will run and then you will get a message that says "Pkzipfix has just made a new 
file called PKFIXED.ZIP located on your Root Drive.    Now use PKunzip to extract the contents of this file 
in a directory of your choice."    When you click on OK you will see that the Source file list box has moved 
to your root directory and you will see the PKFIXED.ZIP file there.    (If there is no PKFIXED.ZIP file on 
your root, Pkzipfix was not able to recover the file.)    Unzip it like you normally would, and, if Pkzipfix was 
successful, you will see the files uncompressing into your Target directory.

NOTE:    There are times when you have more than one ZIP file that you want to unzip together; perhaps 
part one and two of a program or collection.    You can choose multiple ZIP files to unzip at the same time 
by holding down your mouse button and selecting the files OR by holding down the Control key on your 
keyboard and clicking on the files that you want to select one by one.    After you have highlighted all of 
the zip files and chosen the Target directory, go to the Un Zip/Lzh/Arj menu.    You will see that the "Extract
Selected List Files" option is highlighted.    When you click on this, the program will unzip all of the files 
you have chosen.    The files from all of the zip files will end up together in the Target directory.

Sub-Topics:



Archivers' Editors
Executing EXE Files
Viewing BMP and GIF Graphic Files
Archivers Delete Target Dir Files and RD Buttons
Un Span file from disk 
Test Integrity of zip fle 



Archivers' Editors
After extracting the ZIP file, the Archivers window provides you with a few options for viewing the files.    If 
you have a text file that you would like to read (such as a readme file), double-click on the file (in the 
Target box) and most text files will automatically appear on your screen.    If you have an unusual text file 
that double-clicking does not load, go to the Editors menu.    This menu gives you a choice of three 
different text editors to view your text.    Notepad allows you to view most small text files, Windows Write 
allows you to view any Windows Write file (having a .WRI extension) and the DOS Editor will allow you to 
view ASCII text files.    Between the three of these options, you should be able to view just about any text 
file you run across.    You also have the option of adding your own text editor or word processing program 
to the Editors menu.    Go to "Chooser Instructions" to learn about how to do this.



Executing EXE Files
The other thing you can do after extracting your files is execute any executable file (.EXE extension).    To 
do this, all you have to do is double-click on the EXE file in the Target file list box .    This will execute 
either a DOS or a Windows program.    If you double-click on a "setup.exe" file, Archivers will take you 
directly to the Windows Program Manager "File Run" command window so that you can run setup in the 
normal fashion.    Executing a program from within Archivers may not always have satisfactory results and
you may need to get out to DOS or Windows to really try it out, but most programs will execute normally.   
This will allow you to try the program and see if you'd like to keep it.    You can also view text files such as 
read.me, readme.txt and read.1st by double-clicking on them in the Target file box.

NOTE:    You may occasionally run across self extracting EXEs, which are files with an EXE extension that
have compressed files within them.    For more information about this type of file, go to Self Extracting 
EXE Files.



Viewing BMP and GIF Graphic Files
Archivers has its own graphics viewer which will allow you to view bitmaps (BMP files) and GIFs.    In 
order to view bitmap files, all you need to do is    double click on the bitmap file that you would like to look 
at.    You will see the picture come up in the center of your screen.    You can maximize the viewer screen 
by clicking the upward arrow in the upper right-hand corner of the viewer window.    To close the viewer, 
click on the close button in the upper left hand corner of the window.    Use the same method to view GIF 
files.    Choose the GIF file that you want to see and then double click on it.    You will notice that the GIF 
viewer has an "Options" menu.    This gives you two options for how the GIF appears on your screen:    
"Stretch" and "Keep Aspect".    If the Stretch option is chosen, the GIF will be stretched to fit your screen.   
If the Keep Aspect option is chosen, the GIF file will keep its proper width to height ratio on your screen.

You also have the option of adding your own graphics viewing program to the Archivers "Viewer" menu.    
This will allow you to view not only bitmap and GIF files, but any graphics file that your viewer supports.    
To find out how to add your own viewer to the Viewer menu, go to "Chooser Instructions."



Archivers Delete Target Dir Files and RD Buttons
If you have unzipped your program into a test directory and you want to clear the directory so that you can
unzip another file, you can use the Delete File(s) button at the bottom of the file list box.    If you do not 
have a file (or files) selected, clicking on the Delete File(s) button will delete ALL FILES in that directory.    
If you have created a test directory that you want to get rid of, you can use the Del Dirs button.    Clicking 
on the Del Dirs button will delete the directory that you have highlighted as well of all of the files in it and 
any subdirectories and their contents.



Un Span file from disk
The Unzip program also has an Un Span option.    This is used only when you have a large ZIP file that 
has been saved on multiple floppy disks.    In order to unzip such a file, you need to insert the final disk, 
choose source and target, and then choose Un Span from the Un Zip/Lzh/Arj menu.    Un Span will take 
the ZIP file off of the disks, combine it into one ZIP file and put it into the target directory.    To unzip that 
file, you then choose it in the Source file list box and unzip it in the normal fashion.



Test Integrity of zip file
The other Unzip option in the Un Zip/Lzh/Arj menu, "Test integrity of zip file" does not actually unzip your 
files, but it tests the integrity of the compression.    Zipping files can sometimes cause errors.    This option 
runs a test on your zip file and brings up the results in a text file on top of the Archivers window.    Use the 
scroll bar at the side of the report box to read the test report and click on the "File" menu and "Exit" to 
close the text file.    You can then choose Un Zip file from the Un Zip/Lzh/Arj menu if you want to go ahead
and unzip the file.



ZIPPING
Besides being able to unzip files, the Archivers window also give you the ability to ZIP files.    This is 
useful anytime you want to save a file or a group of files into a smaller amount of memory space.    You 
may also want to use it when space isn't a problem, but you want to combine multiple files into one for 
electronic transport or transport on a disk.

In order to zip a file or a group of files, you need to choose the source file or directory first and then the 
target directory.    To simply zip everything in the source directory, choose your source directory and then 
go up to the Compress menu and choose "Zip Options" and then "Zip compress Dir(s)".    The program 
will ask you for a name for your zip file.    Type any name, without an extension.    You will then see the 
hourglass appear as the files are being compressed. (Or, if you have the "Visual On" option chosen, you 
will see a DOS window appear and it will show each file being added to the zip file.)    When compression 
is complete, you will see the ZIP file in your target directory.    The Zip Dir(s) option also works with 
directories containing subdirectories.    When you choose Zip Dir(s), the program will ask you whether or 
not you want to include the subdirectories in the zipped file.

Sub-Topics:
Create Self-extracting EXE 
PKzipfix (repair zip file) 
Zip File(s)
Add Files to Zip File
Update Target zip file (freshen method) 
Update Target zip file (update method) 
Span Disk (-u and -ul)



Create Self-extracting EXE
The "Zip 2 Exe" option takes a ZIP file and changes it into an EXE file (executable).    This is helpful if you 
need to send a compressed file to someone who does not have PKZIP or other programs to uncompress 
the file.    Once the file has been made into an EXE file, it can be executed on any computer running DOS 
and the files will automatically be uncompressed.    Note, however, that changing a ZIP file to an EXE file 
adds at least 13 K to the size of your file.



PKzipfix (repair zip file)
This menu item runs the PKzipfix program.    If you have a ZIP file that you think may be corrupted, 
choose it in the Source file list box and then choose this menu item.    The PKzip program will then 
attempt to correct the ZIP file and will place it into a file called "pkfixed.zip" on your root directory.    You 
can then unzip it from there in the normal way.



Zip File(s)
The next option in the Zip menu is "Zip compress File(s)."    This is the option to choose if you want to zip 
only one file, or a selected group of files, instead of an entire directory.    Choose a single file by 
highlighting it or multiple files by holding down the mouse button and selecting a group of files, by holding 
down the Control key and clicking on the files that you want to select, or by choosing a file extension in 
the file extension box above the Source file list box.    After selecting the file(s) select the target directory 
in the regular way.    Choose Zip File(s) from the Zip Options sub-menu in the Compress menu and a ZIP 
file will be created in the target directory.



Add Files to Target Zip File
This option allows you to add a file or files to a zip file that already exists.    To use this menu item, choose
the file or files that you wish to add in the Source file list box and choose the ZIP file that you want to add 
them to in the Target file list box.    Then choose "Add File(s) to Zip File" and the selected files will be 
compressed and added to the zip file.



Update Target zip file (freshen method)
This will be a very useful option for you if you are using a zip file for ongoing backup purposes.    When 
you choose this option, PKZIP will compare the contents of the ZIP file chosen in the Target directory with 
the files specified in the Source directory.    If a file in the Source directory already exists in the Target zip 
file, PKZIP will check to see if the file in the Source directory is more recent than the file in the ZIP file.    If 
it is more recent, it will replace the file in the zip file with the newer file in the Source directory, but if it is 
not more recent PKZIP will skip over the Source file and not re-compress it into the ZIP file.    

Note that this process will not compress files from the Source directory that do not already exist in the 
Target zip file.    You will have to use the "Update Target zip file (update method)" option to do that.



Update Target .zip file (update method)
This is almost exactly the same as the Update zip file freshen option.    It compares the contents of the 
ZIP file chosen in the Target directory with the files chosen in the Source directory.    If a file in the Source 
directory already exists in the Target ZIP file and is newer, it will be updated in the ZIP file.    If a file in the 
Source directory exists in the ZIP file and is not newer, PKZIP will skip over it and not add it to the ZIP file.
If a file exists in the Source directory that does not exist already in the Target ZIP file it will be added to 
the ZIP file.



Span Disk (-u and -ul)
The final two options in the Zip Options sub-menu are "Span Disk -u" and "Span Disk -ul."    These allow 
you to take a very large ZIP file (larger than the size of your floppy disk) and save it on multiple disks.    
The Span Disk option also formats the disk before saving the ZIP file onto it.    The Span Disk -u specifies 
a regular high density formatting process, and the Span Disk -ul option specifies formatting for low density
disks.    To use span disk, choose the ZIP file that you want to put onto disk and then choose your disk 
drive as your Target directory.    Choose Span Disk (for the correct disk density) and the program will then 
prompt you to put in the disks as they are needed.    When the process is complete, you will be returned to
the Archivers window.



LHA Program
The LHA compression program (which creates LZH files) is the compression program which is most 
widely used in Japan.    You will find LZH files all over the world, though.    

Sub-Topics:
View Lzh File
Uncompressing LZH Files
LZH Menu - File Compression



View Lzh File
Using View Lzh File gives you the opportunity to view the contents of your Lzh files before opening them.  
It works exactly the same as the View Zip File utility.    You can access this utility by either double clicking 
on an lzh file in the Source or Target list box, choosing "View contents of Lzh File" from the Un Zip/Lzh/Arj
menu after selecting an lzh file in the Source or Target list box, or by clicking on the right mouse button 
and bringing up the "instant menu" (after selecting an lzh file in the Source list box).    View Lzh File gives 
you a list of all the files within your lzh file and details about the compressed and uncompressed size of 
the file.    Another useful feature of the View Lzh File utility is that it allows you to view text and help files 
from within your lzh file without uncompressing it!    Simply double click on any file with 
a .txt, .wri, .hlp, .doc, .bat, .me, .1st, or .bas extension and the program will automatically uncompress the 
file and bring it up on your screen for you to read.    When you're finished viewing the file just close it.    
The text file remains in your lzh file.

Sub-Topics:
Options



Options
NOTE:    All of the menu items listed below can also be accessed by using the right mouse click pop-up 
menu in the View Lzh File window.

The first tool in the View Lzh File Options menu is "Delete Selected Files from File."    This allows you to 
remove selected files from your lzh file without uncompressing it.    Simply choose the file or files (select a 
group of files by holding down the mouse button and selecting a group of files, OR by holding down the 
Control key and clicking on the files that you want to select) that you want to delete and then choose the 
"Delete Selected Files" option.    The files you have selected will be removed from the lzh file, leaving the 
rest of the lzh file intact.

You can also extract a single file or selected files by selecting the files (once again,    by holding down the 
mouse button and selecting a group of files, OR by holding down the Control key and clicking on the files 
that you want to select) and then choosing "Extract Selected Files from File" from the "Options" menu.    
The View Lzh File box will then ask you to choose a destination directory to extract the files into and will 
extract only the selected files into the selected directory.

The next item in the Options Menu is "View Selected File (Text)" which accomplishes the same thing as 
double clicking on a text file as described above.    And the final Option is Anti Virus Scan.    When you 
choose this option, Archivers runs a virus scan program which checks the entire lzh file.    It then creates a
report to show you whether any viruses were found.

The "Clear" menu option of the View Lzh File box will clear out any selections that you have made and let 
you start over again.



Uncompressing LZH Files
If you have a file with the LZH extension that you would like to uncompress, the process is exactly the 
same as for a ZIP file.    (I suggest that you read the PKZIP instructions in this help file, if you have not 
done so already.)    Click on the file that you want to uncompress, with the LZH file extension, and then 
choose your destination directory in the Target box.    Go to the Un Zip/Lzh/Arj menu and choose "Un Lzh 
file".    You will then see the LZH file being uncompressed into the destination directory.    

The Archivers program also tests the LZH file before uncompressing it.    If the file has been corrupted in 
any way, you will get a message that reads "There is a problem extracting this file.    Would you like to try 
to extract anyway?"    If you choose yes, the LHA program will attempt to recover the file.    If it is 
successful, you will see the file being uncompressed into your Target directory.    If no files appear in the 
Target directory, LHA was unable to recover the file and you may not be able to uncompress it.

Sub-Topics:
Un Lzh file (retain directory structure) 
Test Integrity of zip file 



Un Lzh file (retain directory structure)
The second Un Lzh menu item in the Un Zip/Lzh/Arj menu is "Un Lzh file (retain directory structure)."    
This is the Un Lzh option which will extract directories and subdirectories of an LZH file if a multi-level 
directory has been compressed.    This Un Lzh option will also work just fine for uncompressing an LZH 
file without subdirectories, so there's no harm done if you choose it by accident.



Test Integrity of LZH file
The third LZH option in the Un Zip/Lzh/Arj menu is "Test integrity of LZH file."    This runs a test on the 
LZH file, similar to the Zip "test integrity" option, and loads the report into a text file on top of the Archivers
window.    The test is especially geared toward testing the integrity of the LZH file, to make sure that it 
hasn't been tampered with by a malicious hacker.    The test integrity option will not tell you anything 
unless there is a problem with the file.    Otherwise, it will just list the files inside of the LZH file.    So, if 
nothing else, this is a quick way to see what files are in your LZH file before uncompressing it.    After 
viewing the Lzh-t text file, choose the "File" menu and click on "Exit" to close the text file.



LZH Menu - File Compression
If you want to compress files using the LHA program, go to the Compress menu and choose the LZH 
Options sub-menu.    The menu has three compression options.

Sub-Topics:
Lha Dir(s)
Lha File(s)
Add File(s) to Target LZH File



Lha Dir(s)
The first option, "Lha compress Dir(s)" is the general, all purpose command for compressing a group of 
files or a directory tree into an LZH file.    The process is the same as for zipping files.    Choose the 
directory containing the files that you want to compress in the Source list box, and then choose the 
destination where you want you LZH file to end up in the Target list box.    Choose "Lha Dir(s)" from the 
LZH Options sub-menu in the Compress menu and you will see the hourglass appear as the files are 
being compressed (or if you have enabled the Visual On option, you will see a DOS window and watch 
each file being added to the lzh file).    When the process is complete, you will see your LZH file in the 
Target directory.    The Lha Dir(s) option also works with directories containing subdirectories.    When you 
choose Lha Dir(s), the program will ask you whether or not you want to include the subdirectories in the 
zipped file.



Lha File(s)
The "Lha compress File(s)," like the Zip File(s) option, allows you to compress a single file or selected 
files.    The process for these options is the same as for compressing directories.    Choose the file or files 
in the Source file list box, choose the Target directory, and then choose the Lha File(s) option from the 
LZH Options sub-menu.



Add File(s) to Target LZH File
Like the Zip "Add Files" option, this option allows you to add a file or files to a LZH file that already exists.  
To use this menu item, choose the file or files that you wish to add in the Source file list box and choose 
the LZH file that you want to add them to in the Target file list box.    Then choose "Add File(s) to Target 
LZH File" and the selected files will be compressed and added to the LZH file.



ARJ Program
View Arj File
Uncompressing ARJ Files
ARJ Menu - File Compression



View Arj File
Using View Arj File gives you the opportunity to view the contents of your Arj files before opening them.    
It works exactly the same as the View Zip File utility.    You can access this utility by either double clicking 
on an arj file in the Source or Target list box, choosing "View contents of Arj File" from the Un Zip/Lzh/Arj 
menu after selecting an arj file in the Source or Target list box, or by clicking on the right mouse button 
and bringing up the "instant menu" (after selecting an arj file in the Source list box).    View Arj File gives 
you a list of all the files within your arj file and details about the compressed and uncompressed size of 
the file.    Another useful feature of the View Arj File utility is that it allows you to view text and help files 
from within your arj file without uncompressing it!    Simply double click on any file with 
a .txt, .wri, .hlp, .doc, .bat, .me, .1st, or .bas extension and the program will automatically uncompress the 
file and bring it up on your screen for you to read.    When you're finished viewing the file just close it.    
The text file remains in your arj file.

Sub-Topics:
Options



Options
NOTE:    All of the menu items listed below can also be accessed by using the right mouse click pop-up 
menu in the View Arj File window.

The first tool in the View Arj File Options menu is "Delete Selected Files from File."    This allows you to 
remove selected files from your arj file without uncompressing it.    Simply choose the file or files (select a 
group of files by holding down the mouse button and selecting a group of files, OR by holding down the 
Control key and clicking on the files that you want to select) that you want to delete and then choose the 
"Delete Selected Files" option.    The files you have selected will be removed from the arj file, leaving the 
rest of the arj file intact.

You can also extract a single file or selected files by selecting the files (once again,    by holding down the 
mouse button and selecting a group of files, OR by holding down the Control key and clicking on the files 
that you want to select) and then choosing "Extract Selected Files from File" from the "Options" menu.    
The View Arj File box will then ask you to choose a destination directory to extract the files into and will 
extract only the selected files into the selected directory.

The next item in the Options Menu is "View Selected File (Text)" which accomplishes the same thing as 
double clicking on a text file as described above.    And the final Option is Anti Virus Scan.    When you 
choose this option, Archivers runs a virus scan program which checks the entire arj file.    It then creates a 
report to show you whether any viruses were found.

The "Clear" menu option of the View Arj File box will clear out any selections that you have made and let 
you start over again.



Uncompressing ARJ Files
The ARJ program works the same as the ZIP and LZH programs do.    When you have a file with an ARJ 
extension that you want to uncompress, click on it in the Source file list box and choose the Target 
directory in the list box on the right.    Then go to the Un Zip/Lzh/Arj menu and click on the "Un Arj file" 
item (the Un Arj items will be highlighted) and you will see the hourglass appear as the files are being 
uncompressed (or if you have the Visual On option enabled, you will see a DOS window and watch each 
file being uncompressed).    You will then see the uncompressed files appear in the target directory.

The Archivers program also tests the ARJ file before uncompressing it.    If the file has been corrupted in 
any way, you will get a message that reads "There may be a problem extracting this file.    Do you wish to 
try to correct this problem by using ARJ Recover method?"    If you choose yes, the ARJ program will 
attempt to recover the file.    If it is successful, you will see the file being uncompressed into your Target 
directory.    If no files appear in the Target directory, ARJ was unable to recover the file and you will not be 
able to uncompress it.

Sub-Topics:
Un Arj file (retain directory structure) 
Test Integrity of ARJ file 



Un Arj file (retain directory structure)
The second Un arj option in the Un Zip/Lzh/Arj menu is Un arj file (retain directory structure), which is the 
same as Un lzh file (retain directory structure).    This extracts ARJ files which contain subdirectories and 
ensures that the directories end up back in the proper order.    The ARJ program actually creates the 
proper subdirectories before it extracts the files into them.    The Un arj x option also works for 
uncompressing normal single-directory ARJ files, so it can be used interchangeably with the plain Un arj 
file option.



Test Integrity of ARJ file
The third ARJ option in the Un Zip/Lzh/Arj menu, "Test integrity of ARJ file," is the same the zip and lzh 
"test integrity" options.    It runs a test on the ARJ file to test its integrity and displays the results in a text 
file on top of the Archivers window.    The Test report displays a list of all of the files in the ARJ file with an 
OK next to them if they pass the test.    After viewing the report text file, click on the "File" menu and 
choose "Exit" to close the text file.



ARJ Menu - File Compression
If you have files you want to compress using the ARJ program, then you can choose an option from the 
Compress menu in the ARJ Options sub-menu.

ARJ is a very complex program with many more switches than we have made available in the Archivers 
window.    You can see a complete list of switches in the Arj Help option of the Archivers Help menu.    Or if
you download the ARJ program from an online service it will have complete documentation with it, and 
you can investigate its many options.    For simple, basic compressing, though, we highly recommend the 
PKZIP program.

Sub-Topics:
Arj Dir(s)
Arj File(s)
Add File(s) to Target Arj File



Arj Dir(s)
"Arj compress Dir(s)" is the standard file compression option for compressing a directory full of files or a 
directory tree.    Choose the directory in the Source directory list box and then pick the destination in the 
Target list box.    When you choose the "Arj Dir(s)" menu option, all of the files in the Source directory will 
be compressed into an ARJ file in the Target directory.    If you are compressing a directory which contains
subdirectories, the program will first ask you whether you want to include the subdirectories.



Arj File(s)
The Arj compress File(s) is the option for compressing single or selected files.    Arj File(s) compresses a 
single file or a selected group of files into an ARJ file.    Choose a single file by highlighting it or multiple 
files by holding down the mouse button and selecting a group of files, OR by holding down the Control 
key and clicking on the files that you want to select, and then select the target directory in the regular way.
Choose Arj File(s) from the ARJ Options sub-menu of the Compress menu and an ARJ file will be created 
in the target directory.



Add File(s) to Target Arj File
Like the Zip and Lzh "Add Files" options, this option allows you to add a file or files to an ARJ file that 
already exists.    To use this menu item, choose the file or files that you wish to add in the Source file list 
box and choose the ARJ file that you want to add them to in the Target file list box.    Then choose "Add 
File(s) to Target ARJ File" and the selected files will be compressed and added to the ARJ file.



Compress/Expand Program
Compress.exe and Expand.exe are used by Microsoft to compress the files in the programs that they sell. 
The two EXEs have been included with Archivers and have been added to your Windows directory.    
Compress and Expand can be accessed in the "Compress" menu.    The Compress program compresses 
each individual file and replaces the final character of the file extension with a "bar" _.    For instance, 
archiver.exe becomes archiver.ex_.    The Compress program is different from Zip, Arj or Lzh in that it 
does not compress a group of files into one file.    You can use the Compress program to compress an 
entire directory of files (by using *.*), but you will end up with the same number of files; all compressed 
with the _ at the end of their file extensions.    The files take up less memory space after compression.

You can use the Compress and Expand programs exactly like you use the other Archiver programs.    
Choose a source file or directory and then choose your target directory.    When using the Expand 
program, you have to expand one file at a time.    You cannot use wildcards.    When you choose a file and
then Expand from the Compress menu, you will be prompted to replace the bar '_' at the end of the file 
extension with the proper letter.    For the file "archiver.ex_", you would take out the bar and replace it with 
an "e."



Compress and Expand Programs
Compress.exe and Expand.exe are used by Microsoft to compress the files in the programs that they sell. 
The two EXEs have been included with Archivers and have been added to your Windows directory.    
Compress and Expand can be accessed in the "Compress" menu.    The Compress program compresses 
each individual file and replaces the final character of the file extension with a "bar" _.    For instance, 
archiver.exe becomes archiver.ex_.    The Compress program is different from Zip, Arj or Lzh in that it 
does not compress a group of files into one file.    You can use the Compress program to compress an 
entire directory of files (by using *.*), but you will end up with the same number of files; all compressed 
with the _ at the end of their file extensions.    The files take up less memory space after compression.

You can use the Compress and Expand programs exactly like you use the other Archiver programs.    
Choose a source file or directory and then choose your target directory.    When using the Expand 
program, you have to expand one file at a time.    You cannot use wildcards.    When you choose a file and
then Expand from the Compress menu, you will be prompted to replace the bar '_' at the end of the file 
extension with the proper letter.    For the file "archiver.ex_", you would take out the bar and replace it with 
an "e."



Self-Extracting EXEs
Besides compressed files with extensions like ZIP, LZH and ARJ, you will also often find compressed files
with the EXE extension.    These are called "self-extracting" EXEs because you execute them like you 
would a normal executable file and then they automatically extract their compressed files.    Obviously 
there is no way to tell just by looking at an EXE file whether it is a regular EXE or a self-extracting EXE, 
but the Archivers program has a test built in to determine what sort of EXE it is.    If you download a 
program from an online service or BBS and it is in the form of an single EXE file, there's a fairly good 
chance that it is self-extracting.    To uncompress a self-extracting EXE, click on the file in the Source file 
list box and choose the destination directory in the Target directory list box.    Then go to the Un 
Zip/Lzh/Arj menu where you will see "Extract Exe" highlighted.    When you click on Extract EXE, the 
Archivers program will first test the file to find out whether it is a self extracting EXE or a regular 
executable program file.    If it is a self-extracting EXE it will be extracted into the Target directory.    If it 
turns out that the EXE file is not a self-extracting EXE, a message box will come up saying "Pkunzip does
not recognize this .EXE file.    Would you like to test for ARJ type EXE?"    The ARJ and LHA programs 
also have the ability to change a file into a EXE file.    If you think your EXE might be one of these, choose
Yes.    The program will then test it again.    If it recognizes it as an ARJ file, it will continue with the 
extraction process.    If not, you will get a message that says "ARJ does not recognize this .EXE file.    Try 
LHA?"    If you choose yes, the program will run another test.    If it is recognized as an LHA file, it will be 
extracted.    If not, you will get a final message that reads "Sorry unable to extract this exe.    May be a 
program file or file is corrupted."



Self Extracting EXE Files
Besides compressed files with extensions like ZIP, LZH and ARJ, you will also often find compressed files
with the EXE extension.    These are called "self-extracting" EXEs because you execute them like you 
would a normal executable file and then they automatically extract their compressed files.    Obviously 
there is no way to tell just by looking at an EXE file whether it is a regular EXE or a self-extracting EXE, 
but the Archivers program has a test built in to determine what sort of EXE it is.    If you download a 
program from an online service or BBS and it is in the form of an single EXE file, there's a fairly good 
chance that it is self-extracting.    To uncompress a self-extracting EXE, click on the file in the Source file 
list box and choose the destination directory in the Target directory list box.    Then go to the Un 
Zip/Lzh/Arj menu where you will see "Extract Exe" highlighted.    When you click on Extract EXE, the 
Archivers program will first test the file to find out whether it is a self extracting EXE or a regular 
executable program file.    If it is a self-extracting EXE it will be extracted into the Target directory.    If it 
turns out that the EXE file is not a self-extracting EXE, a message box will come up saying "Pkunzip does
not recognize this .EXE file.    Would you like to test for ARJ type EXE?"    The ARJ and LHA programs 
also have the ability to change a file into a EXE file.    If you think your EXE might be one of these, choose
Yes.    The program will then test it again.    If it recognizes it as an ARJ file, it will continue with the 
extraction process.    If not, you will get a message that says "ARJ does not recognize this .EXE file.    Try 
LHA?"    If you choose yes, the program will run another test.    If it is recognized as an LHA file, it will be 
extracted.    If not, you will get a final message that reads "Sorry unable to extract this exe.    May be a 
program file or file is corrupted."

 




